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Photoshop Version 20 

In this lesson, we’re going to take a look at the changes that were made in the most 
recent update to Photoshop. With this new update, we are now on Photoshop 
version 20. Adobe has made some big changes to certain areas of Photoshop and 
small changes to a bunch of features that you use every single day.  

Updating Photoshop

You should have the Adobe Creative 
Cloud App installed on your machine 
and you will see the Creative Cloud icon 
in the menu bar in the top right corner 
of your screen. Click on the icon and the 
Creative Cloud panel will expand. Click 
on the Apps category at the top of this 
panel and you will see a list of all your 
installed Adobe Apps with notifications 
of any updates available. Simply click the update button next to Photoshop. If, for 
some reason, the panel is not showing you that there is an update available for 
Photoshop, click on the icon that looks like three little dots in the upper right cor-
ner of the panel and choose Check for Updates from the menu that appears. 

Content-Aware Fill

One of the bigger changes that Adobe has made in this version of Photoshop has 
to do with the Content-Aware Fill feature. This is a feature that has been in Photo-
shop for a long time. In the past, you would make a selection around the area you 
want to fill, then you would go to the Edit menu and choose Fill. The Fill dialog box 
would appear, you would make sure the Contents menu was set to Content-Aware 
and then you would click OK. This still works, but there is now an alternative meth-
od that will give you a lot more control. 

Access the Creative Cloud panel by clicking 
the Creative Cloud icon (circled) at the top of 
the screen. This is where you will go to update 
to the latest version of Photoshop.
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Using the new method, you will still begin by making a selection around the area 
you want to fill. Then, you will go to the Edit menu and choose the new option, ti-
tled “Content-Aware Fill.” A new screen will appear (that basically takes over your 
interface) and it is split into two halves. On the left side, you will see the original 
image with the selection that you created as well as a green overlay. The area high-
lighted in green is the area that Photoshop might choose to copy from in order to 
fill in the selection. On the right side is a preview of what the end result will look 
like. Use the slider on the bottom of this preview window to zoom in and out on 
the image. 

The new Content-Aware Fill window is shown above. On the left is a view of the selection 
(the area you want to fill) and the right window shows a preview of the result. 
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Sometimes Photoshop will use some totally 
inappropriate content to fill in the selected 
retouch area and we now have some more 
control in that we can interact with Pho-
toshop, telling it what areas it should not 
use. Do this by clicking and dragging over 
the area you do not want to be used to fill 
in the selection. In the video example, we 
want our selection to be filled in with clean 
background content, so we painted over the 
leaves that were located next to the selec-
tion. This removed the green overlay on the 
area that we painted so we know that it can’t 
be used to fill in the selection. 

If you would like to ADD green overlay (tell-
ing Photoshop that it’s ok to source from 
a certain area), hold down the Option key 
(Alt on Win) and paint over the desired 
area. If you don’t want to use the keyboard 
shortcut, you can use the little plus and mi-
nus buttons at the top of the screen. If the 
plus icon is active, you will be painting in the 
green overlay. If the minus icon is active, you 
will be removing the green overlay. Note that 
holding down the Option key (Alt on Win) 
simply switches the setting to the opposite that is currently active. For example, if 
the plus sign icon is active and you hold down the Option key (Alt on Win), it will 
temporarily activate the “subtract the overlay” setting when you paint. When you 
release the key, it will go back to the “add the overlay” setting. You can also tap the 
E key to switch between the two modes. To change the brush size, either use the 
Size setting located in the bar above the image window or you can use the square 
bracket keys to make the brush bigger (  ]  ) or smaller (  [  ). 

We are painting over the leaves next to 
the retouch area. This is removing the 
overlay, telling Photoshop that this area 
can NOT be used to fill the selection.

Use these icons to determine whether 
your paint strokes will add to the overlay 
or remove the overlay.
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Sampling Options There are a series of con-
tent-aware settings located on the right side of 
the screen. The top check box, “Show Sampling 
Area,” is automatically turned on and this is what 
allows the green overlay to be visible. Below this 
check box are the settings for how the over-
lay looks. You can use the slider to change the 
opacity of the overlay and you can use the Color 
setting to change the overlay to a different col-
or. The “Indicates” menu is automatically set to 
Sampling Area and this means that the overlay 
will appear over the area that Photoshop might 
use to fill in the selection. You could switch this 
to Excluded area if you’d rather the overlay ap-
pear over the area that Photoshop can NOT use 
to sample from. 

Fill Settings The next category of settings are 
the Fill Settings and these are a really great new 
feature. The old version of Content-Aware fill 
was not able to rotate or scale things, but these 
settings now enable us to do that. When you 
turn on the Scale check box, you are giving Pho-
toshop permission to scale the content as much 
as it needs to in order to best fill in the selected 
area. The Rotation Adaptation menu allows us 
to determine how much freedom we are giving 
Photoshop to rotate the source content. You have the choices of None, Low, Medi-
um, High and Full. Experiment with these options, watching the preview window to 
see what kind of effect each setting is giving you. Turning on the Mirror check box 
will allow Photoshop to mirror content in order to better fill in the selected area. 
Again, experiment with this setting to see if it gives you a better result. 

The Content-Aware Fill settings 
are located on the right side of 
the screen by default and include 
Sampling Options, Fill Settings and 
Output Settings. 
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Output Settings The Output settings are another great new addition. With the old 
Content-Aware version, you could not use the feature while you were working on 
an empty layer. This means you had to apply the change directly to your image lay-
er. Now, we can use the Output To menu to decide that we want the results to be 
placed on a new layer. This will just take the area inside the selection (the retouched 
area) and place it on its own layer. You can also choose to apply the retouching on 
a duplicate layer, or on the current layer (as was the default in the past). 

Additional Content-Aware Fill features  There will inevitably be times when you 
get a tricky image and the Content-Aware Fill feature does not initially create a 
good result. In a case like this, there are ways in which we can help. In one of the 
video example images, we have a scene where there are men playing a board game 
but there are some distracting legs peeking into the top of the frame and we want 
to remove them. We made a selection around the legs and then opened the Con-
tent-Aware Fill window. In the preview window, we saw that the initial result was 
not ideal. The filled area was blotchy with a dark spot. If this is ever the case, look 
at your selection in the window on the left. If the edge of the selection runs close 
to the object you want to remove, Photoshop can get confused. Additionally, take 
into account any shadows that the unwanted object is casting. In our example, the 
legs have cast a shadow, but we did not initially include the shadow in the selection. 
If this ever happens to you, know that you do NOT need to exit the Content-Aware 
Fill window and remake the selection. We can change the selection right within this 

Above, we set the Output To menu to New Layer, which placed the retouch area (the area 
inside the selection) onto its own layer. The Background image layer stayed unchanged.
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area. Activate the Lasso Tool that is located in the Tool Bar on the left side of the 
screen and use this tool to click and drag on the image, adding to the selection. In 
the example, we are extending the selection to include the shadow. In the Preview 
window, the image will update as you change the selection. Know that you can use 
the standard keyboard shortcuts for working with the Lasso Tool (Shift key to add 
to the selection; Option/Alt key to remove from the selection). 

Above, you can see the selection 
we’re trying to retouch on the left 
and the initial result on the right. 
Looking at the selection, the edge 
is too close to the legs and the 
selection does not incorporate 
the shadow. At left, we are using 
the Lasso Tool to add to the se-
lection, including the shadow so 
that the Content-Aware Fill fea-
ture can do a better job. 
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There are also some Lasso 
Tool settings that appear 
above the image window, 
including four icons that de-
termine how the selection is 
going to be created. When 
the icon on the left (the sol-
id square) is active, it means that you’re going to be making a brand new selection. 
When the second icon (two solid squares overlapping) is active, you will be adding 
to the selection. The third icon will cause the Lasso Tool to take away from the se-
lection. The fourth icon is the intersection option and it allows you to basically crop 
into a selection, keeping only the part of the active selection that you encircle with 
the Lasso Tool. 

The Feather setting will allow you to create a softer edge to the selection. I find 
that I usually use a hard-edged brush here, because when you fade out the edges 
of the selection, Photoshop will not have full control over what’s happening to the 
image all the way out to the edge. This can cause it to blend poorly. 

The icon to the right of the Feather setting looks like two triangles. When 
you turn this setting on, Photoshop will smooth out the edges of your se-
lection to eliminate any jagged edges. I usually keep this setting turned on. 

The Expand and Contract settings will allow 
you to fine-tune your selection by expanding 
or contracting it by a specific number of pix-
els. Let’s say you want to contract the selec-
tion, making it a bit smaller. You will first set 
the menu (to the right of the Expand/Con-
tract buttons) to the number of pixels you 
want it to contract by. Then you’d simply click 
the Contract button and your selection will 
shrink by that specified number of pixels. Ev-
ery time you click that Contract button, it will 
shrink by that specified amount.

Use these settings to control how the Lasso Tool works. 

The Expand & Contract settings allow 
you to make the selection larger or 
smaller by a specified number of pixels.
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There are times when the Content-Aware 
Fill results are going to give you areas that 
are miss-matched in brightness or color. 
This can often times happen when you 
have a gradient in a smooth sky. In our 
video example image, we can see that the 
pavement on the left is bright, the pave-
ment on the right is dark and the transi-
tion between the two areas does not look 
natural. When this happens, the Color Ad-
aptation setting (on the right side of the 
interface) can be helpful. Try bumping this 
setting up, one level at a time, to see if this 
makes an improvement. 

Return to default settings After working 
with some of the settings on the right 
side of the interface, you might decide 
that you don’t like the results at all. If this 
is the case, you can set a particular sec-
tion of settings back to their default po-
sitions by clicking the little U-turn icon 
to the right of the setting header name. 
To reset ALL of the settings within the 
entire panel, click the U-turn icon that’s 
located at the very bottom of the panel. 

Rearranging the Content-Aware Fill window layout You can change the way the 
Content-Aware Fill windows are arranged by clicking and dragging on the tabs 
at the top of each panel. Drag the panel around and you will see a blue highlight 
showing you where the panel will be docked when you release the mouse button. 
If you release the mouse button when there is no blue highlight, it just means that 
the panel will be “floating.” It will not be docked/attached to any other panels. Per-

Click the U-turn icon to revert a section of 
options back to the default settings. 

The Color Adaptation setting will attempt 
to correct for areas of mismatched color or 
brightness. 
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sonally, I like to position my settings panel on the left side of the screen instead of 
the right, which is its default position. To collapse a panel down, click on the little 
double-arrow icon located at the very top of the panel. Clicking this will contract 
the panel down to an icon. Click it again to re-expand the panel. 

Zooming and moving around the Content-Aware image window We mentioned 
earlier that you can use the slider beneath the preview window to zoom in and out 
on your image. In the Preview window, you can use the Hand Tool to click and drag 
within the window to reposition the image so you’re looking at the area you want. If 
you hold down the Shift key while dragging with the Hand Tool, you will be moving 
the original image on the left as well. This is nice because it allows you to position 
both windows to the same location in your image at the same time. 

Click and drag on the tab at the top of a panel (circled) in order to reposition it within the 
Content-Aware Fill interface. 
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I find it can be useful to be zoomed out on the original image on the left so that I 
can see what areas have an overlay and which don’t. To fit the left, original image 
into the window, use the keyboard shortcut Command+0 (Ctrl+0 on Win). Then, I 
like to zoom the preview window to the specific retouch area. This way, I can make 
modifications to the selection and overlay on the left while closely viewing the re-
sult on the right. 

When working with the Content-Aware Fill feature, I often times like to keep a zoomed-out 
view on the original image on the left (so I can see where the overlays are) and a zoomed-in 
view on the preview so I can better see the result. 
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Tackle a big job one piece at a time  When you have a really complex retouch job, 
you may not be able to fix everything with one pass through the Content-Aware Fill 
window. You might have to use the feature multiple times in order to tackle all of 
the areas you want fixed. In the video example image, we have an art deco building 
that has a palm tree in front. We want to remove the entire palm tree, which is a big 
job. After making a selection around the tree, we opened the Content-Aware Fill 
window. The initial result is very messy, but after we turned on the Mirror check box 
and set the Rotation Adaptation setting to Low, the result improved dramatically 
and that’s because we gave Photoshop permission to copy content from the left 
side of the building, mirror it and then use it to fill in the right side of the building. 

Here you can see an example of a more complicated retouching job (removing an entire palm 
tree). After making a selection of the palm tree, we entered the Content-Aware Fill window 
and you can see that the initial results on the right were very messy. 
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While this did an amazing job, I still see some small problems when I zoom in on 
the image. We’ll tackle those problems later, in a separate pass through the Con-
tent-Aware Fill window. Before clicking the OK button, however, we’re going to set 
the Output To menu to Duplicate Layer. This will create a new layer that is a dupli-
cate of the original, but it will contain the results of the Content-Aware Fill work. In 
an instance like this, we do not want to choose to output the result to a New Layer 
because that new layer would contain only the retouch area and the rest of the lay-
er would be empty. In many cases, this would be fine (desirable even). However, in 
this case, we want to go back into the Content-Aware Fill feature and it would not 
work well if a good part of the layer was transparent. 

After correcting the biggest problem with the image, we’ll move on to the smaller 
ones. We’ll just need to decide the best method of retouching for each additional 
area that needs to be fixed. The Content-Aware Fill feature might be best to correct 
some areas while the Clone Stamp Tool might be better to correct other problems. 

After turning on the Mirror check box and setting the Rotation Adaptation option to Low, the 
results improved dramatically.
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A different way of tackling a big job like removing the palm tree would be to re-
move the tree in pieces. We could make a selection just around the bottom part 
of the trunk and then enter the Content-Aware Fill window to fill in just that piece. 
Then, we could move on to another part of the tree, and so on. These are just dif-
ferent ways of thinking about how you might tackle a more complicated job. 

When using the new Content-Aware Fill feature, remember the following:

• You must have a selection active before accessing the Content-Aware Fill  
window.

• The Content-Aware Fill feature will not work on an empty layer (or mostly-emp-
ty layer). You CAN, however, save out the retouching results to a new layer. 

Here, we are taking a different approach to removing the palm tree. We are instead removing 
it in pieces, starting with the bottom part of the trunk, where it intersects the fence. 
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Frames

The Frame Tool is another new feature that Adobe has added in 
this version, and you can find it in the bottom part of the Tool Bar 
on the left side of the interface. This tool is great for creating tem-
plates that will speed up future work. When this tool is active, you 
will be able to choose between a rectangular frame and a circular 
frame and this choice can be found in the Options Bar above the 
main image window. 

To create a frame, first choose be-
tween the rectangular or circular 
options and then click and drag out 
the shape in your document. A new 
frame layer will appear in the Layers 
panel and it will have the frame icon 
in the lower right corner of the lay-
er thumbnail. To take the contents of 
a particular layer and place it inside 
the frame, simply drag the layer (in 
the Layers panel) on top of the frame 
layer and release the mouse button. 
You will see the image appear inside 
the frame and it will automatically be 
converted into a smart object. You 
can see the smart object icon appear 
in the lower corner of the frame con-
tents’ thumbnail. It does this because 
it assumes that you’re going to be re-
sizing the image a few times. When a 
layer is a smart object, it is in some-
what of a protective bubble where no 
quality will be lost when you resize it. 

The Frame Tool

We’re placing an image into a frame by dragging 
the image layer onto the frame layer. 

When an image is placed into a frame, it is  
automatically converted into a smart object.  
You can see the smart object icon in the  
corner of the thumbnail. 
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When you have a frame layer, you can ei-
ther work on the frame itself or the con-
tents of the frame. The active part is the 
part that’s going to change when you 
scale, rotate or transform the layer. If the 
image is active but the frame is not, we 
can resize the image inside of the frame, 
but the frame itself is going to stay the 
same. Whichever of the two is highlight-
ed with white brackets is the one you’re working on. Click between the two thumb-
nails to change between which one you’re working on. Click on the name of the 
layer to make both of them active at the same time. We can also use the Move Tool 
to click on the frame outline within the document and this will make the frame ac-
tive. We can then click and drag on the square frame handles in order to resize it. If 
you double-click somewhere within the frame, it will make both the frame and the 
contents active at the same time, so you can move and resize them both together. 
Double click within the frame a second time and it will activate just the contents 
of the frame (the picture) so you can move it around independently of the frame. 

When working with a frame, you will be able to see both the frame border and the 
border of the image itself so that you can see how far the image extends beyond 
the frame boundaries. 

The white brackets around the thumbnail will 
indicate which part you’re working on. Here, 
the brackets are around the image, which 
means that we can resize and transform the 
image while the frame will stay unchanged. 

When you’re working with 
an image inside of a frame, 
you can see the frame edges 
(blue outline), but you can 
also see how far the image 
extends beyond the frame 
boundaries (gray outline).



Photoshop Version 20 © Ben Willmore, All rights reserved 17

There are other ways to get a photo into an existing frame in your document. If you 
drag an image from Bridge, Lightroom or the Finder into the Photoshop window 
and then hover the cursor over the frame, you will see the frame edge become 
highlighted. When you release the mouse button, the image will be placed inside 
the frame. If there was already an image in the frame, it will be replaced with the 
new one. 

Using Frames to create templates Frames can be used to create a photo layout 
from a template that we design. This will allow us to quickly drag images into the 
frames and change them out frequently. To create a template, simple create a se-
ries of frames in the layout you want. If you’d like to quickly create a duplicate of an 
existing frame, hold down the Option key (Alt in Win) while you click and drag on 
the existing frame. This will drag out a copy of that frame. 

Here, we clicked on an image within Bridge and are dragging it directly into the frame we 
created in Photoshop. 
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Add images to the template simply by dragging them into the individual frames. 
Next, you will want to reposition the images within their frames. To reposition an 
image, make sure that its layer is active and then double-click within the frame to 
select the image and simply drag it around to position it correctly. 

Above, you can see how a template can be created from a series of frames and then  
populated with images. 
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Different ways of creating frames Outside of using the Frame Tool, there are a 
couple of other methods you can use to create frames. You can take an existing 
shape layer and turn it into a frame so that you can easily place an image inside it. 
To do this, right-click on the name of the shape layer in the Layers panel and when 
the pop-up menu appears, choose to Convert to Frame. A small dialog will appear 
where you can give the frame a name and then click OK. This allows you to have 
frames that are different shapes (not just circular and rectangular). You can also 
create a frame from a shape layer that was created from a path. To do this, you 
would use the Pen Tool to create a custom path. Then, with the path active, you 
would click on the Adjustment Layer icon at the bottom of the Layers panel and 
choose Solid Color. Choose any color from the Color Picker that appears and click 
OK. This will take that path and turn it into a shape layer. Then, you can right-click 
on the name of the shape layer and choose Convert to Frame from the menu that 
appears. 

Here, we are tak-
ing a custom path 
and turning it into 
a frame. With the 
path active, we 
clicked on the 
Adjustment layer 
icon at the bottom 
of the Layers pan-
el and chose Solid 
Color from the pop-
up menu. The Color 
Picker appeared 
(shown at left) and 
we can choose any 
color and click OK. 
This will turn the 
path into a shape 
layer.
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A text layer can be used as a frame as well. You would follow the same steps. Cre-
ate the text layer, right click on the layer name in the Layers panel and choose to 
Convert to frame from the menu that appears. 

Let’s say that you have a object that is NOT a shape layer and was not created from 
a path or text. There is a trick for turning it into a frame. First, you’d need to create 
a selection from that object. To easily create a selection around the entire contents 
of a layer, hold down the Command key (Ctrl on Win) and click on the layer thumb-
nail in the Layers panel. This works the same way for the contents of a mask. In 
the video example, we created a selection based on the contents of a mask (some 
hand-drawn text) by holding the Command key and clicking on the thumbnail for 
the mask. With the selection active, open the Paths panel and click on the little 
menu in the top right corner of the panel. When the pop-up menu appears, choose 
Make Work Path. A dialog box will appear, asking you to type in a Tolerance setting. 
This just specifies how closely Photoshop should try to match the selection when 
creating the path, and how smooth the edges should be. We chose 2 in the video 
example but you can experiment with other numbers to see what works for you. 
Click OK and a path will be created from the selection that was active. 

We are creating a 
path from an active 
selection. With the 
Paths panel open, we 
clicked on the corner 
menu (circled) and 
are choosing to Make 
Work Path.
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Make sure the path is active, go back to the Layers panel, click on the Adjustment 
Layer icon at the bottom of the panel and choose Solid Color from the pop-up 
menu. The Color Picker will appear, choose any color and click OK. Now you will 
have a shape layer based on that path. Right-click on the name of the shape layer 
and choose Convert to Frame from the pop-up menu. 

The Frame Properties panel When 
you have a frame layer active, the 
Properties panel will contain vari-
ous settings relating to that frame. 
You can use the options in the 
Properties panel to fine-tune the 
size of the frame and choose what 
image should be inserted into the 
frame. You can also use the Stroke 
setting to add a border around the 
frame, and it allows you to speci-
fy the thickness and color of that 
border. 

Filling a frame with a linked smart object We mentioned before that you can drag 
an image from another program (Lightroom, Bridge, etc.) into a frame. If you hold 
down the Option key (Alt on Win) while dragging the image, it will create a linked 
smart object. A linked smart object is special because it will automatically update 
if any changes are made to it. If you make a change to the original file, that change 
will be updated in any Photoshop documents using that file as a linked smart ob-
ject. Note that if making the changes in Lightroom, you must be saving to xmp files 
in order for those images to be updated as linked smart objects. You can quickly 
save out xmp files by selecting the image (or images) in Lightroom and then using 
the Save command, Command+S (Ctrl+S in Win).

When a frame is active in the Layers panel, the 
Properties panel will contain a series of settings 
relating to that frame.
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The Color Wheel 

The Color panel has been around for 
a while, but a new feature has been 
added to it with this update to Pho-
toshop. If the Color panel is not visi-
ble in your interface, you can access 
it by going to the Window menu and 
choosing Color. This panel basically 
contains the equivalent to the Color 
Picker. You can use it to choose your 
foreground and background colors. 
The new feature added in Photo-
shop version 20 is the color wheel 
and you can find it by clicking on the 
“hamburger menu” in the top right 
corner of the panel and choosing 
Color Wheel from the pop-up menu. 

The color wheel gives us a new way 
of choosing colors and it consists of 
a ring that allows us to choose the 
basic color and a triangle that allows 
us to determine the brightness and 
saturation.

You will first choose the basic color that you want by clicking on the ring. Then, 
you determine how bright and saturated that color should be by clicking within the 
triangle. Clicking on the far left side of the triangle will give you very little color and 
clicking on the right side will give you the most saturated color. How high or low 
you click will determine how bright the color will be. 

Above is the new color wheel feature that can be 
accessed via the menu in the top right corner of 
the Color panel. 
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Using the color wheel for color correction The color wheel can also be used to see 
what a color’s opposite is and this can help us with color correction. When there is 
a color cast to your image, you can remove the cast by introducing more of the col-
or’s opposite, and you can see what that opposite is by looking at the color wheel. 
For example, if our image has a blue color cast, we can look at the color wheel 
and find blue. Then, we’ll look directly across from blue to find what its opposite 
is, which is yellow. We could then introduce more yellow into the image in order to 
remove the blue cast. 

The color wheel can also help us choose colors that work together. If we look at the 
wheel and choose colors that are equally spaced apart from each other, we’ll know 
that they are equally different in color and may therefore work better together. 

HSB sliders Above the color wheel, you will find HSB sliders. These stand for Hue, 
Saturation and Brightness. The Hue slider controls the basic color and moving this 
slider is the same as working your way around the color wheel ring. The Saturation 
slider controls how colorful the chosen hue is and moving this slider is the same 
as moving left and right in the triangle. Moving the Brightness slider is the same as 
moving up or down in the triangle. The numbers to the right of each slider basically 
give you a way of describing the color you’ve chosen. If you need to tell someone 
else how to create the same color, you would simply give them the number values 
for the Hue, Saturation and Brightness. 

Out of gamut colors  Note that there are some colors that you 
can create with the color wheel that will not be able to be used 
within your document. Each document has a designated color 
space and this color space determines how vivid of a color you 
can create. The most common color spaces are sRGB, Adobe 
RGB and ProPhoto RGB. If you ever use the color wheel to 
choose a color that can’t be used in your document, a warning 
symbol will appear to the left of the HSB sliders. It looks like 
an exclamation point icon and it means that the color is out of 
gamut and it can’t be used in the document. Click on the warn-
ing icon and it will give you the next-closest usable color. 

The out of gamut 
warning is circled 
above.
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Foreground and background colors The swatch-
es in the upper left corner of the panel represent 
the foreground and background colors. One of 
these swatches will have a border around it and 
that is the color that you’re changing by using 
the color wheel. If you’d like to switch what color 
you’re working on, simply click between the two 
swatches. 

Save to swatches In the lower right corner of the 
panel, there is an icon. Clicking this icon would 
add the current color to your Swatches panel. 
You will first be presented with a small dialog 
where you will be prompted to give the new col-
or swatch a name decide whether you’d like the 
swatch to be added to your current library.

Smaller changes [but still useful!] changes to Photoshop

Text A few small changes have been made to the 
way the Text Tool works. To add text, you first acti-
vate the Text Tool (within the Tool Bar on the left side 
of the screen) and then click within your document. 
In the past, when you clicked within the document to 
add text, it simply placed a cursor so that you could 
start typing. Now, it inserts a bit of placeholder text 
that is automatically selected. It is selected so that you 
can change the font, size, etc. within the Options Bar 
and see that placeholder text update with the changes. This allows you to deter-
mine the look of the text before you even start typing. When you do start typing, it 
replaces the placeholder text with the text that you type in. 

The foreground 
and background 
color swatches. 
The foreground 
color is the one 
we’re working  
on here. 

Clicking this icon 
in the lower right 
corner of the  
panel will add 
the current color 
to the Swatches 
panel.

When using the Text Tool, 
click once within your doc-
ument and Photoshop will 
create placeholder text that 
is automatically selected. 
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With this newest version, it is now much easier to edit text while in the Move Tool. 
It used to be that you would need to switch to the Text Tool in order to work with 
text. Now, if you have the Move Tool active, you can double-click on an area of text 
and it will automatically switch you to the Text Tool. It will also select the text so 
that you can quickly make changes to it. When you’re done working with the text, 
you can simply switch to a different tool or a different layer and it will automatically 
commit to the changes you’ve made. 

Free Transform We just mentioned that when you are working with Text, you can 
simply switch to a different tool or a different layer and it will automatically com-
mit to the changes you made to the text. This functionality now works with other 
Photoshop features as well, including the Free Transform feature. You can free 
transform a layer or the contents of a selection by clicking on the Edit menu and 
choosing Free Transform. Alternatively, you can use the keyboard shortcut Com-
mand+T (Ctrl+T on Win). After using the transform handles to change the layer or 
object, you used to have to click the Return/Enter key or click the check mark in 
the Options Bar to tell Photoshop to Exit the free transform feature. Now, you can 
simply click away from the free transform box to commit the changes and remove 
the transform handles. You can also click on a different tool or a different layer to 
commit the changes and exit the free transform feature. 

In the past, when working with the Free Transform command, you would compress 
or expand the targeted object by dragging the transform handles. If you wanted 
to maintain the proportions, you would need to hold down the Shift key. Now, the 
Free Transform feature will constrain the transformation so that the proportions 
stay the same. You no longer need to hold down the Shift key. 

When you rotate something using the Free Transform command, it’s going to ro-
tate around the center point. In previous versions of Photoshop, there used to be 
a crosshair in the center of the free transform box and you could reposition this 
crosshair to determine the rotation point. This crosshair is now hidden by default 
but you can make it visible again by turning on the anchor point check box located 
within the Options Bar. (Note that the Free Transform command must be active in 
order for you to access this check box.) 
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If you would like the crosshair to show 
up by default every time you use the 
Free Transform command, there is a 
setting you can change for that. Click 
on the Photoshop menu and choose 
Preferences > Tools. (In Windows, 
the Preferences can be found un-
der the Edit menu.) Then turn on the 
“Show Reference point when using 
Transform” check box. You can now 
also change the color of the control 
points and you would do this within 
the Preferences dialog as well. Click 
on the Guides, Grid & Slices category within the Preferences dialog and use the 
Control Color menu to specify the color. 

Distribute objects based on space between them  When you have more than one 
layer selected, a series of alignment controls will appear in the Options Bar above 
the main image window. Click on the ellipsis icon ( … ) to access more icons, includ-
ing the settings for distributing the selected layers an equal distance from each 
other. In the past, there were only settings to distribute based on the center point. 

This would work fine if all of the ob-
jects were the same size. If the objects 
were not the same size, however, they 
would not look like they were evenly 
distributed. Now, with this version of 
Photoshop, there are two addition-
al options and these let us distrib-
ute objects so that there is an equal 
amount of space between them. One 
of the settings will distribute the ob-
jects horizontally and the other will 
distribute the objects vertically.

Turn on the Refer-
ence Point check 

box (circled above) 
to make the cen-

ter crosshair visible 
inside the free trans-

form box (right). 

When more than one layer is selected and the 
Move Tool is active, the alignment icons will 
appear in the Options Bar. There are now two 
additional alignment settings (circled) that will 
allow us to place equal space between objects.
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Adding math into text fields Photoshop now 
allows us to “ do math” in any of the numeric 
text fields. For example, let’s say that we want 
to make a frame twice as wide as it currently 
is. We could open the Frame Properties panel 
and work with the Width field. Instead of calcu-
lating in your head what the width dimension 
would be if it were doubled, we can simply add 
*2 at the end of the number. Photoshop will au-
tomatically multiply the number by two. If you 
wanted it to be half as wide, you would simply 
add /2 at the end and Photoshop will do the 
division. With this feature, you can use addition, 
subtraction, multiplication and division, and you 
can also work in percentages. 

Instant blending mode preview In the past, you’d have to use a keyboard shortcut 
in order to cycle through the different blending modes to see how each one af-
fected the active layer. Now, you can click on the blending mode menu and, as you 
hover your cursor over the different modes, there will be an instantaneous preview 
in your document. 

The Photoshop home screen When you close your 
Photoshop document, the Photoshop home screen 
will appear. In the past, if you did not want to see 
the Photoshop home screen, you would need to 
switch to a different workspace. Now, you can sim-
ply click the Photoshop icon in the upper left cor-
ner and it will take you back to Photoshop’s main 
interface. 

We can now use math within numeric 
fields. Here, we’re adding *2 to the 
width field to make the active frame 
twice as wide.

Click the Photoshop icon in the 
home screen to return to the 
main interface.
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On the far left side of the Options Bar, we used 
to be able to find an icon for the active tool. That 
is still there. It has just moved to the right by one 
slot. Now, on the far left side of the Options Bar 
is a little Home icon. Clicking this will bring up 
Photoshop’s home screen. 

The home screen will display all of your recently-opened images, including all of 
the images you currently have open. If you have many images open, it can be chal-
lenging to try to switch between them, or find a particular one, via the document 
tabs at the top of the image window. It might be easier to click on that home icon 
and simply select the image you want to switch to from the home screen. 

On the left side of Photoshop’s home screen, there is now an added option called 
LR Photos. Clicking this will show you all the photos that you have uploaded to the 
Cloud via Lightroom.

Lock Workspace If you always like your Photoshop tools set up the same way, you 
can now use the Lock Workspace setting, which can be found by clicking on the 
Window menu and choosing Workspace > Lock Workspace. When your workspace 
is locked, you will not be able to reposition or rearrange tools or panels. 

Interface font size Photoshop’s preferences 
allow you to change the font size of the user 
interface in some panels. Go to the Photoshop 
menu and choose Preferences > Interface. 
(On Windows, the Preferences can be found 
under the Edit menu.) Here, you will find the 
UI Font Size menu. This will change the font 
size in some areas of Photoshop. This feature 
is not new. What IS new is the “Scale UI to 
Font” check box. When you turn this check box on, it will look at the size setting 
you are using in the “UI Font Size” menu and it will scale the rest of Photoshop’s 
interface an equal amount. For example, if we set the menu to Large, it means that 
Photoshop’s icons will also get larger. 

Click on the home icon on the left 
side of the Options Bar to return to 
Photoshop’s home screen.

In the Interface section of Photoshop’s 
Preferences, you can choose the font 
size and then specify that the rest of 
the interface be scaled to match. 
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Symmetry mode When the Brush Tool is active, 
there is a setting in the Options Bar called Sym-
metry Mode. Its icon looks like a butterfly. This is 
not actually a new feature, but you had to manually 
enable it in the past (via the Preferences dialog). 
Now, it always appears in the Options Bar. This fea-
ture allows you to paint symmetrical designs using 
all different types of symmetry. If you choose the 
vertical line from the dropdown menu, then it will 
overlay a vertical line on your document and any-
thing you paint on the left side will be duplicated 
and mirrored on the right side, and vice versa. If 
you choose the Duel Axis option, what you paint 
will be duplicated and mirrored in quadrants. Some 
of the symmetry options are fancier, like the Mandala mode. When you choose this, 
you’ll be prompted to choose how many segments you want and this will deter-
mine how many times your strokes will be duplicated in a circular fashion. If you 
created a design using Symmetry mode and you wanted to move it around in your 
document, click on the Symmetry icon and choose Transform Symmetry from the 
menu that pops up. Transform handles will appear around the design so you can 
move, rotate or scale it. When you’re finished creating a design in Symmetry mode, 
click on the icon again and choose Symmetry Off from the menu. 

When the Brush Tool is active, 
the Symmetry Mode menu will be 
available in the Options Bar. 

FAR LEFT: The 
Quadrant setting 
is being used in 
Symmetry mode. 
DIRECTLY LEFT: 
The Mandala set-
ting is being used 
and we chose to 
use six segments.
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Undos The keyboard shortcut for undoing something is Command+Z (Ctrl+Z on 
Win). In the past, you could only use this to undo the very last thing you did. If you 
tried to use it again, it would redo the step (instead of undo it). That has now been 
changed. Now, you can use the Undo command multiple times and it will keep 
taking you backwards in your Photoshop history. This would be the same thing 
as going to your History panel and clicking back through the steps. If you want to 
redo the steps you undid, you will simply hold down the Shift key in addition to 
Command+Z. 

If you are very accustomed to the old keyboard shortcuts for undoing, or stepping 
backward, and you are not ready to commit to the new method, you can get those 
shortcuts back by doing the following. Go to the Edit menu and choose Keyboard 
Shortcuts. The dialog box will appear and near the top is a check box, titled “Use 
Legacy Undo Shortcuts.” Turn this on and the old shortcuts will work for you. (Note 
that you will have to restart Photoshop before this change takes effect.) 

New keyboard shortcut options We mentioned above that you can access the 
Keyboard Shortcuts dialog by going to the Edit menu and choosing Keyboard 
Shortcuts. Near the top of the dialog is a “Shortcuts For” menu and there is now 

a new item here called Taskspaces. If 
you select this, you will be able to as-
sign different keyboard shortcuts for 
the different settings within the new 
Content-Aware Fill interface as well as 
the Select and Mask interface. If you 
click on the “Shortcuts For” menu and 
choose Tools, there are also a few new 
items at the bottom of the tools list. 
These will allow you to assign cus-
tom keyboard shortcuts for Toggling 
Symmetry On/Off, as well as toggling 
Symmetry Visibility. Within the Keyboard Shortcuts dialog, you now 

have the option to assign shortcuts to the set-
tings within the Content-Aware Fill and Select 
and Mask interfaces. 
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Layer names  In the past, if the name 
of your layer was very long, it would 
show the beginning part of the name 
followed by “ …”.  Now, the ellipsis ( 
… ) will appear in the middle of the 
layer name and you will be able to 
see what’s at the very end of the lay-
er name. Note that if you hover your cursor over the layer name and pause, a little 
tool tip box will appear that contains the entire name. This can be convenient if 
your layer name is really long and you need to read the whole thing. 

Flip Horizontal If you click on the View menu, there is now an option called Flip 
Horizontal. This is not actually going to change your image by flipping it. It’s just 
going to change your view of it. It will LOOK as if you flipped it, but if you save it 
and close it, you can look at it later and see that if was not, in fact, flipped. Flipping 
your view can sometimes make it easier to evaluate your picture because you will 
be looking at it in a different light. That’s why the feature exists. 

Changes to Adobe Camera Raw 

HDR Panorama Merge With this new update, Adobe has made it much easier to 
merge HDR panoramas. An HDR panorama is basically a panorama that is merged 
from a series of images that were already merged for HDR. That’s a lot of merging! 
In the past, we would first have to take each individual panorama frame (that was 
shot for HDR) and merge the HDR images. Then, we would take those merged im-
ages and merge them into a panorama. 

Now, the process is different. In Bridge, select all of the images that were shot to 
create the panorama. This includes each individual image in the HDR brackets. Then, 
go to the File menu and choose Open in Camera Raw. All of the images will appear 
in the Filmstrip on the left side of the Camera Raw interface. Click on the little menu 
in the top right corner of the Filmstrip and choose Select All. With all of the images 
selected, click on that menu again and choose Merge to HDR Panorama. 

If you have a long layer name, an ellipsis will 
appear in the middle, but you will be able to see 
what’s at the very beginning and the very end.
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The HDR Panorama Merge Preview win-
dow will appear and it is very similar to 
what you’re used to seeing with the regular 
Panorama Merge window. Toggle the Pro-
jection setting between Spherical, Cylin-
drical and Perspective to see which looks 
best to you. The Boundary Warp slider will 
attempt to make the edges of the panora-
ma extend to the edge of the frame (if the 
Auto Crop setting is turned off). The Auto 
Crop check box will crop out any transpar-
ent areas along the edges of the frame. Because we used HDR images, there is also 
a check box titled “Apply auto tone and color adjustments.” Turn this on in order to 
see the full brightness range captured by the HDR images. You don’t need to turn 
this on, but if you leave it off, know that you will need to adjust the end result. 

With all of the images selected in Camera 
Raw, click on the menu in the upper right 
of the filmstrip and choose “Merge to HDR 
Panorama.”

The new HDR Panorama Merge window in Adobe Camera Raw looks very similar to the regu-
lar panorama merge window, but it includes the Auto-Tone option.
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Click the Merge button in the bottom right corner of the window. You’ll be prompt-
ed to name the file and choose where it should be saved. The merged result will be 
a DNG file, which will have all the same qualities of a raw file and you can further 
fine-tune the image in Camera Raw. 

On occasion, you might run into an 
error message when trying to merge 
an HDR panorama. This could hap-
pen if the bracketing range was not 
consistent across exposures. To pre-
vent this from happening, I recom-
mend using the auto-bracketing fea-
ture in your camera so that all of the 
exposures are consistent. 

Note that this feature is also in Lightroom but it will not work with smart objects. 
Also, if there was any motion in your scene, I suggest using the manual method 
for merging an HDR panorama because this new method does not include any 
de-ghosting settings. De-ghosting tries to get rid of any motion in the scene. 

HEIC Files  If you have an iPhone 7 Plus or newer, your camera will have two lenses 
and can therefore shoot in Portrait Mode. With Portrait Mode, you can make the 
background in an image look soft while keeping the subject in focus. These imag-
es are saved in a special file format called HEIC and we can do special things with 
these types of files in Camera Raw. You will have to research the best way to get 
the file (in that format) onto your computer. I like to use the settings within Light-
room’s mobile app. There is a setting called Technology Preview where you can 
turn on an option for capturing these types of files. With whatever method you 
choose, you’ll need to be careful that it transfers the image as an HEIC file and not 
a jpeg file. 

With the file selected in Bridge, go to the File menu and choose Open in Camera 
Raw. Here, we can apply a selective adjustment (with the Adjustment Brush, for 
example) and then scroll down to the Range Mask menu on the right side of the in-

You may get this error if the bracketing range was 
not consistent across exposures.
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terface (It’s located below the adjustment 
sliders). Here, there is a new option called 
Depth. This option will only show up with 
this particular file format and it will allow 
you to selectively apply your adjustment 
based on the depth of field of different 
parts of the image. When you select this 
option, a series of settings will appear. 
The first is the “Visualize Depth Map” 
check box. If you turn this on, you will get 
a preview of what the camera interpreted 
as being the subject of the photograph. This will be represented by the brighter 
areas. The dark red areas are what the camera deemed as being the background of 
the photo and this is the part that it tried to blur. The Depth Range sliders will limit 
the areas to which the adjustment can take effect. The areas with the overlay will 

receive the adjustment. If you hold 
down the Option key (Alt on Win) 
while dragging the Depth Range 
slider, you’ll get a black and white 
preview of what’s being affected. 
You can also define a range by us-
ing the Eyedropper tool located 
just above the Depth Range slider. 
With the Eyedropper active, click 
and drag out a rectangular selec-
tion that encompasses the depth 
range you’d like to target. When 
you release the mouse button, the 
Depth sliders will automatically be 
moved to encompass that range. 

If you use one of the selective adjustment 
tools in Camera Raw, and you are working 
on an HEIC file, the Range Mask menu will 
now contain an option called Depth. 

Here, we are using the eyedropper tool located just 
above the Depth slider to drag out a selection in 
our image that encompasses the depth range we’d 
like to work on. 



Photoshop Version 20 © Ben Willmore, All rights reserved 35

After setting this slider, you can work with the adjustment sliders and the changes 
will only affect the depth range that you specified. The Smoothness slider is locat-
ed beneath the Depth Range slider and if you hold down the Option key (Alt on 
Win) while dragging this slider, you’ll get a preview of what it’s doing. The areas in 
white are where we’re changing the picture and the areas in black are where we are 
not changing the picture. The Smoothness setting controls the transition. 

New Process Version Any time that Adobe changes the way the sliders work in 
Camera Raw, they’re going to update the process version. The reason for this is so 
you can open older images (ones that were processed when the sliders behaved 
differently) and they will still look the same. They don’t suddenly have newly-de-
signed features applied to them automatically. 

By holding down the Option key (Alt on Win) while dragging the Smoothness slider, you’ll 
get this view of your image, which will give you a better idea of how the slider is affecting 
the depth range mask. 
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Any time you open an image that was ad-
justed with an older process version, you will 
see a little exclamation point icon in the low-
er right corner of the image window. If you 
click on this icon, it will update the image 
to the newest process version. Sometimes 
you won’t even notice any changes to the 
image because they are so subtle. With this 
new process version, Adobe has changed the 
way Camera Raw deals with high ISO images 
so they look a little cleaner when you bright-
en them and zoom in on the shadows. They 
have also made improvements to the Dehaze 
slider. 

This icon will appear when you open 
an image that was last adjusted with 
an older process version. Click on the 
icon to update the image to the current 
process version.


